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ABSTRACT

Menu Controller was developed to make existing software
more accessible for people with severe motor impairments,
especially individuals who use mouse-replacement input sys-
tems. Windows applications have menus that are difficult
to access by users with limited muscle control, due to the
size and placement of the menu entries. The goal of Menu
Controller is to take these entries and generate customizable
user interfaces that can be catered to the individual user.
Menu Controller accomplishes this by harvesting existing
menu items without needing to change any existing code in
these applications and then by displaying them to the user
in an external toolbar that is more easily accessible to peo-
ple with impairments. The initial challenge in developing
Menu Controller was to find a method for harvesting and
re-displaying menu items by using the Windows API. The
rest of the work involved exploring an appropriate way for
displaying the harvested menu entries. We ultimately chose
an approach based on a two-level sliding toolbar. Experi-
ments with a user with severe motor impairments, who used
the Camera Mouse as a mouse-replacement input system,
showed that this approach was indeed promising. The ex-
periments also exposed areas that need further research and
development. We suggest that Menu Controller provides
a valuable contribution towards making everyday software
more accessible to people with disabilities.
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1. INTRODUCTION
1.1 Motivation

A key concept in enabling computer control for people with
disabilities is “transparent access which allows them to use
any commercial software application through whatever in-
put device they employ” [24]. However, there still exists a
huge gap between the control afforded by specialized input
devices and the accessibility provided by commercial appli-
cations. Although creating custom application software for
users with disabilities, when software with the same func-
tionality already exists for able-bodied users, is not always
the most feasible or economical solution [24], sometimes it
is the only usable solution for these users.

The inspiration for Menu Controller came from existing re-
search on methods of providing access to specific Windows
applications to people with severe motor impairments. These
efforts include, but are not limited to, IWebExplorer [23],
which provides access to the web by embedding a web browser
control and providing an on-screen keyboard to the user;
HAILbrowser, which provides toolbars with large buttons to
access links on web pages within an embedded browser that
serves up mobile versions of web pages; and HAILtwitter,
which uses HAIL’s toolbar system to control a user’s Twit-
ter account. In the paper describing the HAIL paradigm, the
authors indicated that future projects were in the planning
stage, which would use HAIL to provide access to “an email
client, news-feed aggregator, Facebook interface, and media
player application” [I9]. While these efforts would provide
a richer and more-easily-customizable experience for these
specific applications, much developer effort is required to
provide this functionality. It became apparent that having a
generic approach to access a subset of the functionality of ex-
isting Windows applications, while other more application-
specific projects are being worked on, would give users the
ability to start using these applications now while they wait



for the richer implementations of their favorite programs to
become reality.

1.2 CameraMouseInterface

Menu Controller was developed for individuals with severely
limited muscle control and tested with a camera-based mouse-
replacement system, the Camera Mouse. The Camera Mouse
[0] is software that was developed at Boston College and
Boston University and is freely available on the web for
download [7]. It is designed for individuals with severe mo-
tor impairments who cannot use their hands to operate a
computer mouse. The software works by tracking a feature
on the user’s face with a web camera, allowing him or her
to control the mouse pointer with head movements. A user
clicks by “dwelling” over the item to be selected - placing
the mouse pointer within a small radius of the item for a set
amount of time, e.g. one second.

Using Camera Mouse, individuals with disabilities can op-
erate specially designed software such as Eagle Aliens and
Eagle Paint [4]. It is also possible for these users to inter-
act with existing software that is not specifically designed
for people with severe motor impairments. However, such
software typically has menu-based user interfaces involving
drop-down menus with small entries that are close to one
another (Figure[2]). These interfaces are usually difficult to
use with Camera Mouse or other mouse-replacement sys-
tems [12] 20] because of the degree of precision they require
in order to choose individual entries. For users of mouse-
replacement systems with and without disabilities alike, it
is difficult to “dwell” within such small areas, so it is com-
mon for users to miss target entries or to accidentally hit
neighboring entries.

In designing specialized input devices for users with disabil-
ities, it is important for users to be able to use the devices
independently, with minimal assistance from caregivers [24].
The same is true for software. If it was easier for users
with disabilities to access menu entries, which often con-
tain key functions or customizations, they could rely less
on assistance from caregivers and have a higher degree of
independence when using applications.

1.3 Redated Work

Our work relates to general work in input and output redi-
rection and reverse engineering of user interfaces. Two proj-
ects utilizing redirection on the Windows platform are mudibo
[16], which can simultaneously duplicate dialog boxes across
multiple monitors, allowing a user to interact with the dia-
log in any location and WinCuts [27], which allows a user
to replicate portions of existing windows and interact with
them as new independent windows. Stuerzlinger et al. [26]
developed User Interface Facgades, a system for adapting
existing user interfaces in general. Their system uses di-
rect manipulation techniques and requires no programmatic
changes to the existing applications. It provides users abil-
ities including: the ability to create new user interfaces us-
ing duplicated screen regions, the ability to add holes to
user interfaces in order to overlay applications on top of one
another, and most relevantly, the abilities to modify the in-
teraction behavior of existing user interface widgets or to
replace them entirely with new ones.

There are also projects that achieve redirection and reverse
engineering of user interfaces with image processing rather
than APT’s or user interface toolkits. The SegMan system
[25] translates pixel-level input, such as the appearance of
user interface components, into objects and symbols for cog-
nitive models, so that the models can interact with existing
Windows applications. Hurst et al. [I4] improve upon the
Microsoft Active Accessibility APD’s [I] ability to detect the
location and size of user interface targets by developing a
hybrid approach that combines the API with machine learn-
ing and computer vision techniques. Finally, Prefab [10] is
a system that uses a pixel-based approach, independent of
specific user interface toolkits or platforms, to reverse en-
gineer the user interface structures of existing applications.
Using input and output redirection, Prefab can then modify
the apparent behavior of these interfaces or even implement
new advanced behaviors.

Our work also relates to work that addresses the target-
ing difficulties some users experience. Similar to how we
address the difficulties that Camera Mouse users have in se-
lecting small, closely grouped menu entries, Worden et al.
[30] address the difficulties that older adults have in mak-
ing small mouse movements and clicking on small targets.
Instead of trying to modify the interface layouts of exist-
ing applications, the authors developed two new interaction
techniques that operate within existing layouts: area cur-
sors — cursors with larger than normal activation areas and
sticky icons — icons that automatically reduce the cursor’s
gain ratio when it is on them, making it easier for the mouse
pointer to stop or “stick” on the icon. The Bubble Cursor
[13] is an improvement on the area cursor such that it dy-
namically resizes its activation area so that only one target
is selectable at any time. Hurst et al. [I5] also address the
problem of making user interface targets easier to select.
They use an adaptive pointing technique where small forces
are associated with past clicks. Frequently clicked-on areas
accumulate a pseudo-haptic magnetic field that draws the
mouse pointer to them in a way similar to sticky icons.

Our work is also related to projects in creating tools that can
provide access to or augment existing applications. Akram
et al. [2] developed an application mediator to give Camera
Mouse users a greater degree of autonomy when launching
applications or switching between tasks. Their system has
an accessible parent menu that provides access to a fixed
set of application tools, including a text-entry program, web
browser and music player. Another accessibility project that
provides a generic approach for accessing more than one ap-
plication is Johar [3]. It provides a mechanism that devel-
opers of applications can implement that will allow external
user interfaces to manipulate their applications. However,
Johar can only be used for applications that are explicitly
designed to cater to the Johar interface. Olsen et al. de-
scribed an architecture for creating interface attachments
— small independent programs, such as a text searcher or a
spell checker, that can augment the functionality of a variety
of applications. Their implementation involves intercepting
components of a Java user interface toolkit in order to ac-
cess the visual information that the applications display on
screen [22].

Finally, our work also relates to similar work in designing



specialized user interfaces for users with severe motor im-
pairments. SUPPLE is a system that automatically gener-
ates personalized user interfaces for individual users based
on their motor capabilities [II]. The HAIL (Hierarchical
Adaptive Interface Layout) model presents specifications for
the design of user interfaces that can change and adapt to
users with severe motion impairments [I9]. The approaches
of both SUPPLE and HAIL look at generating user inter-
faces at a programmatic level; creating more usable and
adaptive interfaces by creating new applications. In Menu
Controller, we address the different but related problem of
generating user interfaces for software that already exists,
for which we do not have access to modifying the underly-
ing source code. We look at how we can transform these
already implemented interfaces to make them more usable
and customizable to the needs of users with severe motor
impairments.

2. METHODS
2.1 Challenges

Early on in the process of developing Menu Controller, re-
search was done to see if it was possible to control the menu
items of a Windows application from an external program.
After trying many different options, we discovered that the
Windows API [2§] is designed to allow developers to simu-
late any action that a user can accomplish with a mouse or
keyboard. Windows messages are sent to individual items
on a window (such as a menu item), and these items re-
spond to these messages in the same way that they would
respond to an actual action performed directly by the user
on that item, e.g. a click. This gives a programmer the
power to control almost any aspect of any window without
knowledge of the inner workings of the window itself.

The next step was to experiment with the MenuAPI [21].
This API is a subset of the WindowsAPI that deals specif-
ically with Windows Menus. Once we figured out which
methods we would need from the API, the work from that
point forward involved testing Menu Controller on several
Windows applications. Of particular interest was our test-
ing with Windows Media Player [29], as we wanted to try to
get one of the programs mentioned in the HAIL paper [19]
working with Menu Controller (Figure B]).

Once it was determined that the WindowsAPI would give
us control of the menu entries, the next step was to decide
how they should be re-rendered by Menu Controller. We
ultimately decided on an approach based on a sliding toolbar,
a design that was developed for the Camera Canvas project
17 [18].

2.2 User Interface

The way in which Menu Controller re-renders the menu en-
tries of an application is based on the user interface of a
new version of Camera Canvas [I§] (Figure [I)), an image
editing program for people with severe motor impairments,
designed for use with the Camera Mouse. Camera Can-
vas uses a toolbar with large buttons to provide users with
motor impairments easy access to the functionality of the
program. We follow a similar approach in Menu Controller:
we re-render application menu entries in large button form
in a toolbar at the top of the screen.

(2 ) [«

Figure 1: The Camera Canvas [18] image editing
program with its sliding toolbar user interface at the
top of the screen. All buttons in the top row (be-
tween “FILE” and “TEXT”) move to the left by one
button position if the “PREV” button is selected.
Similarly, all buttons move to the right by one posi-
tion if the “NEXT” button is selected.

When a user navigates to an application with a menu, the
user first sees the root entries of the menu. Similarly, when
Menu Controller first encounters an application, it displays
the root menu entries as a sequence of large buttons (Fig-
ure [3). When a user clicks on an entry in the root menu of
the application, a submenu is typically displayed (Figure ).
The same behavior is achieved in Menu Controller. When
one of root buttons is selected, a list of buttons for the asso-
ciated submenu replaces the root buttons, and so on. When
a user is navigating a menu, its submenus disappear when
the user clicks off of the menu. At this point the user again
sees only the root menu entries. Menu Controller behaves in
a similar way: when a user clicks off of Menu Controller and
onto the main window of the application, Menu Controller
again renders the root menu entries of that application.

The sequence of large buttons displayed by Menu Controller
have a sliding functionality. The toolbar has two arrow but-
tons: a “Prev” and a “Next” button that enable the user
to “slide” the toolbar across the screen, that is, collectively
moving the positions of the menu buttons on the screen. The
aim of the sliding functionality is to help users who cannot
reach certain areas of the screen. For example, if a user can-
not reach a button at the far left of the screen, the user can
click on the arrow buttons and continually slide the toolbar,
moving the button towards the middle of the screen, until
the button is within the user’s reach. The direction of sliding
is from the perspective of looking at the space between the
two arrow buttons in the center of the screen. The “Prev”
arrow button causes the button in the previous position to
the center to slide to the center, and the “Next” arrow causes
the button in the next position to the center to slide to the
center.

2.3 How Menu Controller Works

When Menu Controller is run, a timer is started and a “tick”
event from the timer is handled by Menu Controller once
every second. The handler first makes a call to the Get-
ForegroundWindow WindowsAPI method, which returns a
handle to the window that currently has focus. If no window
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Figure 3: Menu Controller’s re-rendering of the View submenu of the Microsoft Windows 7 Calculator [6]
program.

currently has focus, i.e., all windows are minimized, Menu
Controller does nothing and simply waits for the next timer
tick. If a window is found, Menu Controller then makes
a call to the GetMenu API function, passing it the handle
to the in-focus window, which returns another handle that
points specifically to the menu of that window. (Note: If the
returned handle is 0, this means that the window either does
not have a menu, or that the menu is not the type of menu
that can be accessed using the MenuAPI calls [21].) Once a
valid handle to a menu is obtained, the first level of the menu
is read (i.e. the part of the menu visible to the user prior
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troller makes a further WindowsAPI call to GetSubMenu [21]
to determine if the item is a submenu or an actual item that
needs to be clicked. If the former, Menu Controller follows
the same steps outlined above to read the menu items of the
submenu, and dynamically create buttons to be displayed,
but this time for the submenu. If the latter, the appropri-
ate information, in this case the handle to the menu along
with the index of the item to be clicked, is sent to the ap-
propriate WindowsAPI methods to simulate the clicking of
the item. These methods include GetMenuItemID [21I] and
SendMessage. GetMenuItemID provides one of the parame-
ters for SendMessage, a generic WindowsAPI method that
is used to send all types of messages to any window. (We
note here that the call to SendMessage has the exact effect
from perspective of the Windows operating system as if the
user had clicked on the menu item directly.)

Lsh .:i Rsh i E | 1 || Z || || | ‘ button. With these two pieces of information, Menu Con-
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Figure 2: The View submenu of the Microsoft Win-
dows 7 Calculator [6] program. The menu en-
tries are small and closely grouped together, making
them difficult to access using the Camera Mouse.

2.4 Two Typesof Menusin Windows
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Figure 5: Menu Controller displaying the Play sub-
menu in Windows Media Player 9 [29].

There are two standard types of menus in Windows. One
is the type that is accessible using the MenuAPI calls [21],
and the other is based on a more recent technology that Mi-
crosoft developed called Active Accessibility [I]. Most legacy
applications use the former type, while newer applications
take advantage of the Active Accessibility technology, which
was developed by Microsoft to allow software developers to
write accessibility tools that can interact with their applica-
tions.

Menu Controller currently only supports the MenuAPI-ac-
cessible menus, which means that it can only support a sub-
set of Windows applications. In our testing, however, we
found that there are many useful programs that use the older
menu style, and concluded that Menu Controller can handle
a large subset of Windows applications.

3. EXPERIMENTSINVOLVING A USER
WITH MOTOR IMPAIRMENTS

We recently conducted experiments with a non-verbal indi-
vidual with severe cerebral palsy and quadriplegia (Figure
[6). The participant has used the Camera Mouse input sys-
tem in the past. For our experiments, we asked the partici-
pant to use Eagle Aliens, a game where the user moves the

mouse pointer around the screen to “shoot aliens” (Figure
M), and Eagle Paint, a freeform line drawing program. Both
are popular programs designed for use with Camera Mouse
[4] that the participant was already familiar with. We ex-
plained that the goal of Menu Controller is to allow a user
to operate more of the program’s features by him or her-
self. The participant especially liked playing Eagle Aliens
and seemed excited at the prospect of being able to start a
new game or adjust the difficulty level by himself.

Functionality, such as starting a new game or adjusting the
difficulty level, is only available via the menu of Eagle Aliens
and could not be accessed by the participant. Only when
Eagle Aliens was used together with Menu Controller could
the participant access the functionality.

When playing Eagle Aliens, the participant was able to use
Menu Controller to open the File menu and start a new
game and adjust the time limit and difficulty settings of the
game.

We observed that it was difficult for the participant to reach
buttons that Menu Controller displayed in the top left corner
of the screen. We explained how the arrow buttons allowed
him to move the buttons toward the center of the screen to
be more within his reach. After a couple of explanations
on how the movement worked, selecting the correct arrow
became more intuitive for the participant. The participant
seemed to like the idea of the arrow buttons, but due to
their placement, they seemed to do more harm than good.
Because of their close proximity to the menu buttons, the
user often had to pass over an arrow button to get to a menu
button. Doing this would sometimes cause the menu but-
tons to slide, shifting his intended target. We learned that
moving the arrow buttons farther from the menu buttons,
or even to a different area of the screen, so that they are not
as easily triggered by mistake, is a much needed change.

Although the participant was able to hit some of the buttons,
in general it was difficult for the user to make movements
to reach the top of the screen. To try to help the user, we
re-initialized Camera Mouse and adjusted the mouse move-
ment gain settings, but the user still had difficulty. It would
be beneficial for this user if the Menu Controller could be
moved to a different area of the screen. Also, the buttons
on the Menu Controller were too close together so when the
user tried to click on a button he would often click neigh-
boring buttons by mistake. It would be very helpful to be
able to adjust the button size and space between buttons at
runtime.

When the participant clicked on the appropriate Menu Con-
troller button to adjust the difficulty level or time parameter
of the game, no feedback was provided to show that the click
was successful, and so the participant would continue trying
to click the same button over and over. Menu options to ad-
just settings, such as “Difficulty” or “Time,” present the user
with a list of options, only one of which can be selected.
In the original Windows style menu of Eagle Aliens (out-
side of Menu Controller), when the user clicks to select an
option, a checkmark appears next to that option to signify
that the option is selected (Figure [2). However, in Menu
Controller there is not yet an equivalent means to provide



Figure 6: A user with motor impairments using
Menu Controller with the Eagle Aliens game.

this type of feedback. A possible future enhancement would
be to change the button appearance in some way such as
by drawing a dark border around the selected item, so as to
provide the user with this feedback.

Several times during the experiment, the user accidentally
clicked outside the application window, causing Menu Con-
troller to automatically hide itself. It would be beneficial if,
when started, Menu Controller automatically resized itself
and the application window to take up the whole screen to
prevent this from happening.

In using Eagle Paint, the participant was able to launch
some menu items such as changing the background color to
black, but still had the same problems as when using Eagle
Aliens. At this point in the experiments the user was also
feeling fatigued so it was even more tiring for him to make
the movements required to reach the Menu Controller at the
top of the screen.

Eagle Aliens and Eagle Paint both require the spacebar key
to be pressed in order to start the main part of the pro-
gram (causing the aliens to appear or the lines to start being
drawn). Because of that, the user still needs the assistance
of a caregiver in order to use the application. It would be
beneficial if we added buttons of common keyboard com-
mands such as “Space”, “Enter” or “Tab” to the toolbar so
that the user can activate programs requiring these keys by
himself.

We learned a lot from the participant of our experiments
and his interaction with Menu Controller and the two appli-
cation programs. It was very encouraging to see his positive
reaction to the software despite the difficulties he had in
using it. We now know the areas where we need to make
improvements and are even more motivated to making the
program as usable as possible.

4. DISCUSSION AND CONCLUSIONS

To address the difficulties that users with motor impair-
ments have in accessing the menu entries of existing applica-
tions, we developed Menu Controller, a tool that can harvest
the menu entries of existing applications and present them
to a user in a form that is more accessible and usable. We
conducted experiments with a user with severe motor im-

pairments and observed that Menu Controller allowed him
to access previously unavailable functionality in applications
that he already uses. The studies conducted with this user
helped us identify areas of improvement and directions for
future research.

Our future work involves incorporating what we learned
from our most recent user study in order to make Menu
Controller more usable. We hope to make the appropriate
changes and conduct another session with the user from that
study. We will also be conducting more user studies with
additional users with and without disabilities and improving
the software based on their feedback.

Eventually, we hope to make the way Menu Controller re-
renders menus highly customizable so that each user can
tailor it specifically to his or her needs and abilities. Cur-
rently, Menu Controller re-renders menus in only a horizon-
tal orientation at the top of the screen with large buttons,
as shown in Figure [ for the example of the Microsoft Win-
dows 7 Calculator. In the future, users should be able to
place the toolbar in different areas of the screen, change its
orientation, and adjust the size and spacing of the buttons.
The goal is for a user to be able to use Menu Controller
with several applications and have a consistent, customized,
and accessible user experience throughout. The great vari-
ety in software user interfaces, often presenting difficulties
even for users without disabilities, bring even more frustra-
tion for users with disabilities who may have to customize
their input devices for every application [24]. With Menu
Controller, our hope is to alleviate some of this frustration
by reducing the number of different application user inter-
faces that users will have to customize their input devices
against.

We are also investigating how to handle the newer Microsoft
Active Accessibility user interface technology [1], which will
make Menu Controller usable with the vast majority of Win-
dows applications that have a menu.

Extensive capture and manipulation techniques for user in-
terfaces were developed in the mentioned works. In our
work, we use more basic techniques, but focus specifically on
users with motor impairments. Utilizing similar approaches
to the ones mentioned, we could improve Menu Controller
to handle other types of user interface widgets in addition
to menus. Currently, our focus is only on the Windows en-
vironment since Camera Mouse is presently only available
to Windows users. However, employing image processing
techniques similar to the systems mentioned above [25] [14]
[T0] could allow us to develop an accessibility tool that is
platform independent.

While the described pointer-targeting techniques may be
helpful to users with motor impairments, they do not pro-
vide much added benefit when used with targets that are
small and close together, such as those in menu entries. Us-
ing these techniques in conjunction with the user interface
created by Menu Controller might increase their utility for
these users.

Eventually, Menu Controller will be made freely available to
the public for download [7]. We hope to allow the extensive



worldwide Camera Mouse user base [§] access to more appli-
cations and to encourage new users in trying Camera Mouse
after seeing that Menu Controller may give them additional
computing ability.

Studies have found that adoption of software to assist com-
puter users with severe motor impairments is sometimes dif-
ficult. Dawe [9] found that the rate that some of this soft-
ware is abandoned due to various factors (including cost and
complexity) is estimated to be upwards of 35%. Our goal
with Menu Controller is, therefore, to make it intuitive and
easy to use in order to attract a user community that will
find it useful while also simple to use. We also hope that
Menu Controller’s support for a number of existing Windows
applications will make its adoption even more attractive.
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